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Overview 
The Slit Image (CCD or film) Test (SIT) combines 
the best of the Caustic & Lateral Wire Test (LWT) 
and avoids their difficulties: 

• The Caustic requires determining the 
Center of Curvature (COC) within 0.001". A 
difficult task [1 - page 223]. 

• With the LWT [6] each zone needs to be 
measured mechanically to better than 
0.0005". A difficult task unless the room 
temperature is closely controlled i.e., 
distance from the mirror to tester changes 
with temperature while the readings are 
being taken.  

 

SIT employees a Caustic type mask, each mask 
hole returning an images of the testers slit, which 
by the way is visible in an eyepiece. But unlike the 
Caustic, all the mask holes are open allowing the 
capture of all the LWT measurements with one 
exposure. 
 

Film Verses CCD 

For a digital SLR (lens removed), you need to 
know: 
 

• CCD cell size. 

• Lens mounting to CCD spacing. 
 

 
Fig. 1. SIT Setup.                                       Image credit: Bill Thomas 
 
 

 
The original image is a 24 meg tiff file, which was cropped and then jpg'ed 

down to 660 k. Do to the jpg compression and cropping your results will 
not exactly match that of the web. For example: After Photoshop Rotate 

Arbitrary CCW 2.97 of the jpg image, I get 165 pixels for the left outer 

slit, and 3202 for the right outer slit.  
 

The difference is 3037 pixels. The web site difference (3225-188) is 3037 

pixels. The web zone pixel differences are: 

   13.8%  467 
   27.6%  931 

   41.5%  1389 

   55.3%  1835 

   69.1%  2258 
   82.9%  2662 

   96.7%  3037                                          Image credit: Bill Thomas 
 

Fortunately, this information was available on the 
WEB for the Olympus E-300, which I use [2, 3]. For 
film, all you need know is the DPI of the scanner. 
The slit image whether film or CCD is processed 
exactly the same. 
 

Note: The Slit or CCD or both can be in front or aft 
of ROC (Fig. 1). LWT experts recommend both in 
front, avoiding the confusion of which ray belongs 
to which hole (behind ROC the rays cross the 
optical axis). My setup has both aft of ROC 
because of the way the camera is attached to the 
tester. That forces both to be behind where the 
outer hole ray becomes the outer slit in the image. 
The examples are that of a 22" f/4.75 - first light 
May 2008. 
 

Photoshop: 

To facilitate measuring: 
The image is rotated using the Measuring Tool and 
Rotate Arbitrary. Using Selection and Levels the 
width of the slits are reduced to the brightest pixels 
– Fig. 4. 
    

The pixel coordinate (Ypix) of the slits are 
measured using the Measuring Tool – Fig. 2 and 5. 

 
Fig. 2. Image Processing.                            Image credit: Bill Thomas 

 
Fig. 3. Crunching The Numbers.                   Image credit: Bill Thomas 
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Bill Thomas and his 22" f/4.75 Dob.                                                                                                                                    Image credit: Bill Thomas 
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Sixtests is available at: 
 

http://home.earthlink.net/~burrjaw/atm/odyframe.htm 
 

Spreadsheet is available at:  
 

http://yubagold.com/tests/computations.php 
 

 
Fig. 4. Photoshop Rotate.                             Image credit: Bill Thomas 
 

 
Fig. 5. Photoshop Levels and Measuring.       Image credit: Bill Thomas 
 

Sanity Checks: 
 

E300 Specs: 

The E-300 was replaced with a fixture positioning 
film at the CCD image plane – Fig. 6. The 
processed images confirmed the E-300's lens 
mount to CCD spacing, and cell size. 
 

 
Fig. 6. Film Verification Fixture.                    Image credit: Bill Thomas 

 

Star Tests 

Two mirrors (22" f/4.7 and a 12.5" f/4.5) were 
figured using SIT, which were then star test 
validated. 
 

Tester Alignment: 

As is the case with the Caustic and LWT, the 
testers longitudinal axis needs to be aligned to the 
mirrors optical axis, and the film plane needs to be 
perpendicular to that axis. All of which is quite 
doable, and is described at: 
 

http://yubagold.com/tests/alignment.php. 
 

Mask Holes 

The mask holes need to be accurately located. 
The mask material I use is 040 ABS (0.040" thick) 
5 inches wide. The 3/4" holes were cut with a 
plunge router, with a threaded rod controlling the 
positioning – Fig. 7. Molding glued to the bottom 
stiffens the mask. Cardboard is then used to 
covers the rest of the mirror. 
 

 
Fig. 7. ABS Mask Making Jig.                   Image credit: Bill Thomas 
 

Note: Accuracy of the hole positions is vary 
important. To that end, the mask is flatbed 
scanned (direction of scan is most accurate). Then 
hole positions are adjusted to compensate for 
parallax i.e., rays are not at right angels to the 
mask. This is done in 'router mask' of SIT.xls. 
 

In the past, had local machine shop make the 
mask for about $90 - still scanned them. 
 

A scanning laser which would start pulsing on 
detection of the edge, would eliminate the need for 
a mask. 
 

Computations 
In the Spreadsheet (SIT.xls; the examples are that 
of a 22" f/4.75 mirror):  
 

Input: 
   

CCD: 
 

• G2 = The E-300 CCD cell size in microns 
(=0.00003937 inches) [2] 

 

• F2 = The E-300 Lens mount to CCD 
spacing [3] 
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• E2 = Slit to lens mount distance – Fig. 13 
and 14 

 

• J2 = The E-300 CCD glass thickness [2] 
 

• K2 = The E-300 CCD glass index of 
refraction [2] 

 
 
 

FILM: 

• D2 = Slit to image plane (usually zero). 
 

H2 = Scanned DPI. 
 
 

A2 = Mirror optical diameter. 
 
 

B2 = ROC initially to +/- 1/8". Then refined from 
Sixtests results. 
 
 

B4:B12 = Zone h's (linked to 'router 
mask'!D12:D18) 
 
 

Accuracy of hole positions is refined by flatbed 
scanning the mask (direction of scan is most 
accurate), and then processed in 'router mask' 
B23:C30 & B33:C40. The hole positions are then 
adjusted, using Solver to compensate for parallax 
i.e., rays are not at right angels to the mask. 
    
        

Solve for the h's - Cells D12:D18 of 'router mask' 
Fig. 12. 
 

    Tools->Solver can only solve for one at a time: 
 

• First: F12 value of 0, By Changing D12 
 

• ............................................................. 
 

• Last: F18 value of 0, By Changing D18 
 

Ypix's As measured in Photoshop. 
 

• D5:D11 left side. 
 

• E5:E11 right side 
 

• D4 = Center. 
 

Used to check if the mask was properly centered. 
If any of the pixel differences, F5:F11 are greater 
than +/- 9, the mask needs to be re-centered and 
the test done again. 
 

Solve for l (C14) – Fig. 11 and 12 
 

    Tools->Solver (computations are relative to the 
edge zone) 
 

• Target Cell = D14, value of 0 
 

• By Changing Cell C14 
 

Solve for the Foucault's - Cells F18:F23. 
 

Tools->Solver can only solve for one at a time: 
 

• First: E18 value of 0, By Changing F18 
 

• .......................................................... 
 

• Last: E23 value of 0, By Changing F23 
 
 

Note: Because the calculations are relative to the 
edge, the outer zones s' (F24) is h

2
/(2R) (using the 

outer zones h). 
 

 

Spreadsheet

 
Fig. 8. SIT Spreadsheet.                             Image credit: Bill Thomas 
 

Using Notepad type (paste) the following info from 
the spreadsheet to create file Sixtests_input.txt – 
Fig. 9. 
 

 
Fig. 9. Sixtests_input.txt.                          Image credit: Bill Thomas  
 

Note: A program to replace the spreadsheet, and 
generate Sixtests_input.txt file is 
underdevelopment. 
 

In Sixtests.exe 

File->Open setup 

• Navigate to file Sixtest_input.txt 

• Click Open 

• Click Surface getting – Fig. 10 
 

 
Fig. 10. Sixtests output.                           Image credit: Bill Thomas  
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Note: The Glass Surface Plot is invaluable when 
figuring. With the exception of interferometry, the 
rest of the tests measure the derivatives of the 
glass surface. Conjuring the surface from the 
derivatives e.g., Foucault is not intuitively obvious 
and is best left to programs like Sixtests.    
 

Equations: 

 
    Fig. 11. Fixed Source-LWT.                 Image credit: Bill Thomas 

 

• Ydiff is the pixel distance between slit pairs 
i.e., Ypix right D5:D11 - Ypix left E5:E11 – 
Fig. 8. 

• Yi = (Ydiff/pixels per inch)/2 i.e., a negative 
value. 

 

Foucault: 

Given the Yi's (G5:G10), the spreadsheet Solver 
tool is used to work the equation Yi=w(Yn-h)+h, 
backwards to obtaining the s' (F18:F23) – Fig. 8 

and 11. 
 

Note:  Because the calculations are relative to the 
edge, the outer zones s' (F24) is h

2
/(2R). 

• Yl = Yi when q = l (Fig. 11). 

• Yl is approximately 2h(s-l)/R 
 

 
Fig. 12. Using Solver.                                  Image credit: Bill Thomas 

 
Fig. 13. Camera Spacer.                             Image credit: Bill Thomas 
 

 
Fig. 14. Spacer Parts.                                  Image credit: Bill Thomas 
 

Alignment/Imaging 
The testers longitudinal axis needs to be aligned to 
the mirrors optical axis, and the film plane needs to 
be perpendicular to that axis. The time consuming 
initial alignment's need be done only once. From 
then on, a laser pointer is used to quickly align the 
tester. 
 
 
 

Initial Alignment 
 

   Longitudinal Axis to the Mirrors Optical Axis: 
 

• Center dot the mirror. 
 

• Mount the mask with the center hole over 
the center dot, also making sure the holes 
are level. 

 

• Observe the center slit with a 10 mm 
eyepiece. Rotate the tester (camera tripod 
works well) horizontally and vertically so as 
to keep the center slit image fixed with 
respect to the upper mat cutter blade while 
moving the tester on the longitudinal axis – 
Fig. 15. 

 

• In order to avoid doing this again, aim an 
attached laser pointer at the center of the 
mirror. Lock the laser pointer down. Mark 
where the returning beam strikes an 
attached card – Fig. 16.  
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Fig. 15. Mat Cutter Slit Assembly.                Image credit: Bill Thomas 
 

    Fig. 16. Quick Laser Optical Alignment. Image credit: Bill Thomas

    
 
 

Source Plane Perpendicular to the Optical Axis: 
 

• Remove the mask, making sure not to move 
the mirror or the longitudinal axis of the 
tester. 

 

• Attach a plastic mirror to the Source Plane – 
Fig. 18. Direct a laser pointer through the 
hole of the plastic mirror to the center of the 
test mirror.  

 

Rotate the Source Plane until the third 
bounce strikes the test mirror's vertical 
centerline – Fig. 17. Lock the Source Plane.  

 
Fig. 17.Perpendicular Alignment to Optical Axis.  

Image credit: Bill. Thomas 
 

 
Fig. 18. Source Plane, Eyepiece and Quick Align Laser.  

Image credit: Bill Thomas 
 

Imaging: 
 

• Center dot the mirror. 

• Align the testers longitudinal axis to the 
mirrors optical axis:  

    

1. Rotate the tester so that the 
attached laser hits the center of 
the mirror – Fig. 18. 

2. Rotate the test mirror until the 
returning beam hits the attached 
card where previously marked – 
Fig. 16.  

 

• Locate COC with the Foucault. It need not 
be precise - useful for the next step. 

• Move the tester aft of COC by an amount 
where the image nearly fills the CCD. After 
a bit, you will know exactly how far aft of 
COC you need to be. Make sure the outer 
slit image is the edge zone image i.e., aft of 
COC the rays cross the optical axis. 

• Remove the KE. 
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• Mount the Mat Cutter Slit Assembly – Fig. 

13. 
 

 
 
 

• Mount the mask with the center hole over 
the center dot, also making sure the holes 
are level. Also, make sure not to move the 
mirror. 

 
 
 
 

• Attach the 10 mm eyepiece to the back of 
the Source Plane – Fig. 18. 

 
 
 

• Move the tester laterally to align the center-
slit image to the edge of the upper mat 
cutter blade – Fig. 18.  

 
 

 

 

• For CCD, E-300 setup:  
   

1. Manual mode. 
2. TIFF 3264x2448. 
3. ASA 1600. 
4. Exposure delay 12 seconds. 
5. Exposure 1/20 of a second. 
6. Remove the lens. 
7. Attach the E-300 to the Camera 

Spacer – Fig. 13. 
8. Click - capturing the image.  

 

• For Film:  
1. In the dark mount the film to the 

image plane. 
2. Expose the film. An enlarger timer 

works well. 
0 

Bill Thomas contact mail address is: bthomas32000@yahoo.com. 
The author’s home page is:               http://www.yubagold.com 
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